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Chapter 1: Introduction
The Wavelink Studio 5.0 User’s Guide is a complete guide to the features and 
components of Studio. This document presents:

• An introduction to the Studio environment and conceptual information 
about the Studio structure.

• Detailed information about each server component and how to configure 
those components effectively.

This chapter presents the following information:

• About This Document 

• Network Configurations 

• Studio Features 

• Additional Sources 

About This Document

The Studio 5.0 User’s Guide focuses on the installation of Studio and how to 
use its features to ensure that mobile device users have reliable connections to 
Wavelink applications.

NOTE This document does not discuss how to develop applications with the 
Studio development libraries.

This section provides information about the assumptions and conventions of 
this user’s guide.

Document Assumptions

This document makes the following assumptions:

• You have a general understanding of the different hardware and software 
components that comprise your network
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• You understand basic hardware configuration, such as installing a 
network adapter

• You have administrative access to your network

Document Conventions

This document uses the following typographical conventions:

Courier New Any time you interact with an option, such as a 
button, or type specific information into a field, such 
as a file pathname, that option appears in the 
Courier New text style. This text style is also used 
for any keyboard commands that you might need to 
press.

Examples:

Click Next to continue.

Press CTRL+ALT+DELETE.

Bold Any time this document refers to an option, such as 
descriptions of elements in a dialog box, that option 
appears in the Bold text style.

Examples:

Click Open from the File menu.

Type a name for the Application Server in the Server 
Name text box.

Italics Any time this document refers to another section 
within the document, that section appears in Italic 
text style. This style is also used to refer to the titles 
of dialog boxes.

Examples:

See the Installation section for more information.

The Choose Install Folder dialog box appears.
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Network Configurations

Studio supports multiple network configurations. The two most common 
types of configurations are for distributed application deployment and 
centralized application deployment. 

The distributed application architecture provides for redundancy of 
applications and services at local sites. This redundancy is critical for 
enterprises that work with public networks or any other environments where 
connections to a central server fall outside an organization’s control. In the 
distributed application model, redundancy at the site level ensures that 
mobile device users can access the applications they need even if a connection 
to a central server is unavailable. This model has the advantage of increasing 
redundancy of critical components and improving the overall robustness of 
the network.

The centralized application architecture is the configuration of choice for 
organizations with a highly-reliable network infrastructure. In this model, 
network reliability renders site-level application redundancy unnecessary. As 
a result, all mobile devices across all locations access a central application 
distribution manager, with redundancy addressed through multiple 
instances of the applications and servers at the central location. This model 
has the advantage of increasing administrative efficiency and reducing the 
number of required server components at a site.

These two configuration methods—distributed and centralized—can also be 
combined. For example, if most of the sites on your network have reliable 
connections to a central server but a few sites do not, you can use the 
centralized method for the majority of your network and use the distributed 
method on an as-needed basis.

Studio Features

Wavelink Studio’s revolutionary approach to wireless application 
management allows you to extend application management, while retaining 
the ease-of-use required of any network management tool. This section 
presents features and fundamental concepts of the Studio product to help you 
optimize it for your enterprise. The features covered in this section include:

• Port Monitors 

• Application Servers 
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• Discovery Manager 

• License Manager 

• Service Manager 

• Administrator 

• Java Development Library 

• Load-Balancing 

• AutoDiscovery 

Port Monitors

A port monitor is responsible for accepting connections from mobile devices. 
There are two types of port monitors, one for the Windows development 
environment and one for the Java development environment.

As the name implies, each port monitor is assigned to a specific port on its 
host system. You can connect to a port monitor directly or use Wavelink’s 
AutoDiscovery feature, where a Discovery Manager provides port monitor 
information to a mobile device requesting a connection.

Unlike other components in Studio, port monitors are automatically created 
and removed by an Application Server.

Application Servers

An Application Server answers the need for effectively managing multiple 
port monitors. As mentioned in the port monitor section, you can have as 
many port monitors as your mobile device users require. However, if you 
have several hundred port monitors on your network, managing each one 
individually becomes inefficient.

Consequently, Studio employs Application Servers to manage port monitors. 
Each Application Server adds and deletes port monitors when you add or 
delete applications on your network. These Application Servers also handle 
communications sent from port monitors to other Studio server components.
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Discovery Manager

A Discovery Manager is a point of contact for a mobile device that wants to 
connect to the wireless network. The Discovery Manager is necessary if you 
want to support Wavelink’s AutoDiscovery feature. See  AutoDiscovery on 
page 10 for more information.

A Discovery Manager has two main functions:

• Maintain a list of all available port monitors

• Respond to connection requests from mobile devices with the appropriate 
port monitor information

When a mobile device attempts to connect to an application, it broadcasts a 
connection request. A local Discovery Manager acquires this request and 
compares its parameters to a list of available port monitors. After comparing 
the connection request to a port monitor list, the Discovery Manager responds 
with the appropriate port monitor information.

License Manager

One of the core elements of Studio is the License Manager. The License 
Manager maintains and distributes all available Wavelink licenses for an 
enterprise-wide network.

When an Application Server is activated on a specific subnet, the License 
Manager immediately allocates a number of licenses to it. As mobile devices 
connect to an Application Server, they are assigned licenses from that 
allocated amount. If the number of connection requests exceeds the number 
of allocated licenses, the server requests additional licenses from the License 
Manager. If licenses are available, the License Manager allocates more 
licenses to the server.

Wavelink licenses are leased to an Application Server for a set period of time. 
When a lease for a license ends, the License Manager returns those licenses to 
its pool of available licenses, ready to re-distribute them on request.

See Chapter 7: Licenses View on page 63 for more information on how to 
efficiently manage and distribute Wavelink licenses.
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Service Manager

The Service Manager tracks the location and status of all other Studio 
components. Each time a server component starts, it locates and registers 
with the Service Manager to become available to the other servers on the 
network.

NOTE Application Servers are never assigned a backup status, allowing you 
to create as many Application Servers as you need for each subnet.

You can have only one Service Manager active on your network at any given 
time.

Administrator

The Administrator provides a functional user interface that allows you to 
manage the different Studio components efficiently. For a full description of 
the Administrator and its functions, see  Overview of the Administrator on 
page 23.

Java Development Library

The Java Development Library is a set of classes that you reference from your 
Java application. The library provides 36 classes and hundreds of methods 
designed specifically for wireless-application development. These methods 
and objects range from basic input and output functions over a wireless 
network to playing custom tone files on an mobile device.

Load-Balancing

Studio handles load-balancing for your wireless applications automatically. 
When multiple servers contain the same application, Studio tracks the 
connection capacity for each Application Server. As new application requests 
are received, Studio routes the connection to the Application Server that has 
the most percentage capacity. This method prevents one Application Server 
from reaching its maximum capacity while another remains unused.

AutoDiscovery

A key feature to Studio is its AutoDiscovery technology. AutoDiscovery is a 
feature that allows mobile devices to locate to and connect with applications 
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on your network without requiring you to configure those devices with 
specific host IP addresses and port numbers.

Additional Sources

The following references also provide additional information on Studio or the 
Wavelink product line:

• Studio Java Development Library

• Studio COM Development Library

• Wavelink Corporation Web site: www.wavelink.com

• Wavelink Studio Client user’s guides
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Chapter 2: Installation
This chapter presents the following installation information:

• Requirements

• Determining the Level of Redundancy

• Installing Studio

• Starting Studio

• Creating Firewall Exceptions

• Uninstalling Studio

Requirements

This section lists the hardware and software requirements of Studio. For 
Studio to operate properly, the minimum requirements are:

• Solaris 9 or 10, Windows Server 2003, Windows 2000 or XP

• 256 MB physical RAM

• 64 MB free disk space (plus additional space for applications)

• Pentium 300 MHz or faster

• If using Solaris, a Java Virtual Machine 1.4 or compatible

Determining the Level of Redundancy

One of the first decisions you must make before you install Studio is the level 
of redundancy your network requires. This level depends on several factors, 
such as the reliability of network connections, the role of public networks 
within daily business activities, and the location of different sites within the 
enterprise. After you determine the level of redundancy, you can install 
Studio using a distributed, a centralized configuration, or a combination of 
both.
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If you want Studio operational on sites regardless of whether they can 
connect to your headquarters, it is recommend you install Studio using its 
distributed configuration. This configuration first involves a standard 
installation of Studio components on a central server. After this installation is 
complete, you install specific components at each site within your enterprise. 
This configuration method ensures that your users can continue to access 
wireless applications even if a site’s connection to your headquarters is 
unavailable.

If you want to control all aspects of wireless management from a central 
location, it is recommended that you install Studio using its centralized 
configuration. With this configuration, you install Studio only on a central 
server. Users within your enterprise must connect to this server to access a 
wireless application.

NOTE If you select a centralized configuration for Studio, sites on your 
network cannot access applications if their connection to the central server is 
unavailable.

See  Network Configurations on page 7 for more information on configuration.

Installing Studio

This section covers the installation process of all Studio components. This 
section also applies if you are installing components of Studio to one or more 
sites. The installation process will be slightly different depending on which 
OS you are using:

• Solaris Installation

• Windows Installation

NOTE If you stop the installation process at any time, you must use the 
uninstall utility to remove any partially-installed components before you 
attempt to re-install.
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Solaris Installation

To install Studio on a Solaris OS:

1 Download Wavelink Studio 5.0 (Studio.bin) from the Wavelink Web 
site, www.wavelink.com.

2 From a terminal, navigate to the directory where Studio is saved, type
 ./Studio.bin and press Enter.

The Installer starts and the Introduction dialog box appears.

3 Click Next.

The License Agreement dialog box appears. Please read this agreement 
carefully.

4 To accept the License Agreement, enable the I accept the terms of the 
License Agreement option and click Next.

The Choose Install Folder dialog box appears.

5 To accept the default installation folder click Next.

To navigate to a different installation folder, click Choose. If you click 
Choose and decide that you prefer the default directory, click Restore 
Default Folder. Once you select a folder, click Next.

The Choose Java Virtual Machine dialog box appears.

6 A list of available Java VMs becomes active in the dialog box. Select a Java 
VM from the list. 

NOTE The Java VM must reside on the same path as Studio. You must use a 
Java VM that complies with the Java 2 Runtime Environment, Standard 
Edition, version 1.4 or compatible.

7 Click Next.

The Choose Link Folder dialog box appears.

8 Select where you want the product icons for Studio components to reside 
and click Next.
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The Choose Product Features dialog box appears.

9 If you want to install all components of Studio, select the Full Install 
option. Select this option if this installation is for a primary installation of 
Studio components.

If you want to install site-only components, select the Site Install option. 
Select this option if this installation is for a specific site within your 
enterprise.

If you want to install only the Administrator user interface, select the 
Administrator Install option.

10 Click Next.

The Pre-Installation Summary dialog box appears.

11 If the installation information is correct, click Install.

• If you are performing a full or site installation, the Specify Server Name 
dialog box appears. Proceed to Step 12. 

• If you are performing an Administrator installation, the Install Complete 
dialog box appears. Click Done to complete the installation. 

12 Type a name for the Application Server in the Server Name text box.

13 Type a password for the Application Server in the Server Password text 
box.

14 If you are performing a site installation, type the IP address of the 
headquarters server in the HQ Server IP text box.

15 Click Next.

The Install Complete dialog box appears.

16 Click Done.

Windows Installation

To install Studio:

1 Download Wavelink Studio 5.0 from the Wavelink Web site, 
www.wavelink.com.
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2 Open the InstallAnywhere Self Extractor to start the installation process.

The Introduction dialog box appears.

3 Click Next.

The License Agreement dialog box appears. Please read this agreement 
carefully.

4 To accept the License Agreement, enable the I accept the terms of the 
License Agreement option and click Next.

The Choose Install Folder dialog box appears.

5 To accept the default installation folder, C:\Program 
Files\Wavelink, click Next.

To navigate to a different installation folder, click Choose. If you click 
Choose and decide that you prefer the default directory, click Restore 
Default Folder. Once you select a folder, click Next.

The Choose Java Virtual Machine dialog box appears.

6 If you want to install the Java VM included with Studio, enable the Install 
a Java VM specifically for this application option.

If you want to use a previously installed Java VM, enable the Choose a 
Java VM already installed on this system option. If you enable this 
option, a list of available Java VMs becomes active in the dialog box. Select 
a Java VM from the list. If the preferred Java VM does not appear in this 
list, click Search For Others to have the installation program search 
for additional Java VMs or click Choose Another to manually navigate 
to a different Java VM.

NOTE You must use a Java VM that complies with the Java 2 Runtime 
Environment, Standard Edition, version 1.4 or compatible.

7 Click Next.

The Choose Shortcut Folder dialog box appears.

8 Select where you want the product icons for Studio components to reside 
and click Next.
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The Choose Product Features dialog box appears.

9 If you want to install all components of Studio, select the Full Install 
option. Select this option if this installation is for a primary installation of 
Studio components.

If you want to install site-only components, select the Site Install option. 
Select this option if this installation is for a specific site within your 
enterprise.

If you want to install only the Administrator user interface, select the 
Administrator Install option.

10 Click Next.

The Pre-Installation Summary dialog box appears.

11 If the installation information is correct, click Install.

• If you are performing a full or site installation, the Specify Server Name 
dialog box appears. Proceed to Step 12. 

• If you are performing an Administrator installation, the Windows 
Service dialog box appears. Skip to Step 16. 

12 Type a name for the Application Server in the Server Name text box.

13 Type a password for the Application Server in the Server Password text 
box.

14 If you are performing a site installation, type the IP address of the 
headquarters server in the HQ Server IP text box.

15 Click Next.

The Windows Service dialog box appears.

16 If you want the Application Server to operate as a Windows service, enable 
the Install Studio as Windows Service checkbox.

17 Click Next.

If you are installing Studio as a Windows service, the Service Startup dialog 
box appears. This dialog box allows you to enable Studio to startup 
automatically or manually. Once you select how Studio starts, click Next.



Chapter 2: Installation 19

NOTE If you choose not to start up Studio automatically, you will need to 
manually start the Application Server each time.

The Install Complete dialog box appears.

18 Click Done.

Starting Studio

This section includes instructions for:

• Starting the Server

• Opening the Administrator

Starting the Server

If Studio is installed as an automatic Windows service, the server will 
automatically start each time the computer is started. If Studio is not a 
Windows service or is a manual Windows service, the server must be started 
manually each time your computer is started. 

NOTE Closing the Administrator does not stop the Studio server.

To start the server in Solaris:

• From a terminal, navigate to the Studio installation directory, type 
Start_Server and press Enter.

To start the server in Windows as an application:

• From the Windows Start menu, select All Programs  > Wavelink 5.0 
> Studio Server.

The server starts and you may now open the Administrator.

To start the server in Windows when Studio is a manual Windows service:

1 From the Windows Start menu, select Control Panel > 
Administrative Tools > Services.
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2 In the list of services, find Wavelink Studio and right-click on it.

3 Select Start.

The server starts and you may now open the Administrator.

Opening the Administrator

The Administrator allows you to access and modify servers, applications, and 
mobile devices on your network.

To open the Administrator in Solaris:

• From a terminal, navigate to the Studio installation directory, type 
Studio_Administrator and press Enter.

To open the Administrator in Windows:

• From the Windows Start menu, select All Programs > Wavelink 
5.0 > Studio Administrator.

The Administrator opens and you can access your servers, applications, and 
mobile devices.

Creating Firewall Exceptions

In order to administer applications with Studio, you must create exceptions in 
the firewall. There are three types of exceptions that must be made for Studio 
to be fully operational:

• Application Exceptions

• AutoDiscovery Exception

• Remote Administration Exception

Application Exceptions

When you add an application to the server, you have the option of specifying 
the port or port range that application will use. Set the port number and then 
create an exception in the firewall for that port.
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NOTE If you use Find Available when selecting a port for the application, the 
port number may change each time you run the application.

AutoDiscovery Exception

To make sure that the firewall allows AutoDiscovery to function properly, 
you must make an exception in the firewall for UDP port 905. For the 
Windows Client, you must make an exception for UDP port 903.

Remote Administration Exception

If you will be administering Studio remotely, you may also need to create an 
exception in the firewall for the Java RMI. This is done by creating an 
exception for the server.

To create an exception in the Windows firewall for the Studio Server:

1 From the Windows Control Panel, double-click on Windows Firewall.

2 Select the Exceptions tab.

3 Click on the Add Program button.

4 Select Studio Server from the Programs list and click OK.

The server will now be allowed to connect to other sites.

5 Make sure that Studio Server is included in the Programs and 
Services list.

You may now manage applications at the site from a remote 
Administrator.

Uninstalling Studio

This section provides instructions for uninstalling Studio.

To uninstall Studio in Solaris:

• From a terminal, navigate to the Studio installation directory, type 
Uninstall_Studio and press Enter.
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To uninstall Studio in Windows:

• From the Windows Start menu, select All Programs > Wavelink 
Studio 5.0 > Uninstall Studio 5.0.

All Studio installation files will be uninstalled from your computer. 
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Chapter 3: Studio Tutorial
This chapter provides an introduction to the Studio environment through 
step-by-step instructions for basic tasks. The sections in this chapter include:

• Overview of the Administrator

• Adding a License to the License Manager

• Adding an Application

• Creating a Firewall Exception

• Connecting to an Application with the Windows Client

• Viewing Connections to Applications

NOTE Before beginning the tutorial, you must complete a full installation of 
Studio.

Overview of the Administrator

You control all aspects of application distribution and management through 
the Administrator. With the Administrator, you can display one of several 
views. Each view contains information about your wireless applications and 
provides you with a collection of options you can use to configure how Studio 
manages those applications. The views contained in the Administrator are as 
follows:

Server Monitor This view allows you to manage the servers, add 
wireless applications, and view users connected to 
your Studio installation.

Applications This view allows you to add, modify, and delete 
applications in Studio.
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Adding a License to the License Manager

The License Manager distributes licenses to your Application Servers. You 
must have one or more valid licenses assigned to a server before you can add 
an application to it. This section describes how to add a license to the License 
Manager.

To add a new license:

1 From the Administrator, click Licenses.

2 Click Add.

The Add New Wavelink License dialog box appears.

Figure 3-1. Add New Wavelink License Dialog Box

NOTE All fields in the Add New Wavelink License dialog box are case sensitive.

3 Type the name to whom the new licenses are assigned in the Licensee text 
box.

Licenses This view allows you to add, modify, delete, and 
reclaim licenses distributed to your servers.

Servers This view allows you to add, modify, and delete 
remote servers. It also allows you to give 
authorization for sites to access wireless applications 
and licenses.
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4 Type the platform version for the licenses in the Platform Version text box.

5 Type the serial number for the licenses in the Serial Number text box.

6 Type the number of users allowed to access these licenses in the User 
Limit text box.

7 Type the authorization code for the licenses in the Authorization text box.

8 Type the expiration date for the licenses in the Expiration Date text box.

9 Click Accept to add the new licenses to the License Manager.

Adding an Application

Once you have added licenses to the License Manager, you can begin to add 
applications. Adding an application to Studio consists of two steps:

• Adding an Application to the Administrator

• Adding an Application to a Server

The sample application used in this tutorial is a Java application called “Hello 
World.” Some information in this tutorial is specific to Hello World. For more 
information about adding applications, see Chapter 6: Applications View on 
page 45.

Adding an Application to the Administrator

You must add applications to the Administrator before they are available to 
your servers and devices. 

To add an application to the Administrator:

1 From the Administrator, click Applications.

2 Click Add.

The Adding New Application dialog box appears.
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Figure 3-2. Adding New Application Dialog Box

3 Type Example in the Name text box.

4 Select Java from the Type list.

Currently, Studio supports two application types: Java and Win32. Because 
the Hello World application is in Java, you must select Java from the 
Type list.

5 Select default from the Application Group list.

6 Select Single Port from the Port list. Specify a port number for the 
application to use in the activated text box.

This option instructs Studio to use a single specified port for the 
application. You can also restrict the port numbers used to a specific range 
or allow Studio to assign the application to any available port.

7 Type Example of adding an application in the Description text 
box.

The description appears in the Description column of the Application 
Distribution Manager table.

8 Type the path to the directory that contains the application in the Local 
Directory or Jar text box.

The Hello World application is located in the following directory:
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C:\Program Files\Wavelink\Studio 5.0\samples\java\helloworld

9 Type wlapps.HelloWorld in the Choose App text box.

10 Select the Absolute on option, and then select the system on which the 
application resides.

With this option, Studio accesses the application only from the system on 
which the application was initially installed, using the exact path specified 
in the Local Path text box. This option is recommended if you do not want 
an application distributed to multiple systems.

11 Click Accept to add the application to the Application Distribution 
Manager.

NOTE You can configure advanced options for your wireless applications. See  
Editing Application Properties on page 51 for more information.

Adding an Application to a Server

Once you have added the Hello World application to the Administrator, you 
can add it to a specific Application Server on your network.

To add an application to a server:

1 From the Administrator, click Server Monitor.

2 Select a server from the Site List.

3 Click Start Application, located in the bottom-left corner.

The Start Application dialog box appears.
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Figure 3-3. Start Application Dialog Box

4 Select the Example application.

5 Click OK.

The Starting Applications dialog box appears.

6 Click Yes.

The Hello World application is now available to mobile devices through the 
server you selected. Notice that the application now appears in the 
Applications list in the Server Monitor view, along with its assigned port 
number and the number of mobile devices currently connected to it. 

NOTE You must also use this port number in the following sections to create a 
connection to the application.

Creating a Firewall Exception

Before you can access Hello World from a mobile device, you must create an 
application exception in the firewall for the port you specified in step 6 of 
Adding an Application to the Administrator. 
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To make an application exception in the Windows firewall:

1 From the Windows Control Panel, double-click on Windows Firewall.

2 Select the Exceptions tab.

3 Click the Add Port button.

The Add a Port dialog box appears.

4 Enter a name for the exception in the Name text box.

5 Type the port for the application in the Port Number text box. (This is the 
port specified in step 6 of Adding an Application to the Administrator.)

6 Ensure that the TCP option is selected and click OK.

The exception is created and you can access the application from a mobile 
device.

Connecting to an Application with the Windows Client

Once you have added the application to a server, you can use the Windows 
Client (included in the Windows full installation) to simulate a mobile device 
connecting to an Application Server. 

The Windows Client is a client that is designed to run on your desktop. This 
Client is a useful tool for verifying application performance and connections.

To create a Windows Client connection:

1 From the Windows Start menu, select All Programs > Wavelink 
5.0 > Windows Client.

The Windows Client opens.

1 From the Client main screen, click on the Add New icon.

The Edit Profile dialog box appears.

2 In the Host Name text box, type Hello World as the name for the 
profile.

This name appears beneath the host icon in the Client main screen.
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3 In the Host Address text box, type 127.0.0.1.

4 In the Port text box, type the port number to which you want the device to 
connect.

5 Click Update to confirm the settings.

The Studio Client creates the new host profile. Hello World appears beneath 
the corresponding icon in the Client main screen.

6 Double-click on the Hello World icon in the Client main screen.

The Windows Client will connect to the Hello World application. 

Viewing Connections to Applications

You can use the Administrator to view details about the mobile devices 
connected to an application.

To view application connections:

1 From the Administrator, click Server Monitor to open the Server 
Monitor view.

2 Select the server that contains the Hello World application from the Site 
List.

In the Applications list, an entry appears that contains the name of the 
application, its assigned port number, and how many devices are 
connected to it. Because you connected to this application through the 
Windows Client, the number of connections should now read 1.

3 Select the Hello World entry from the Applications list.

In the Application Users list, an entry provides information on the type of 
device connected to the application, the IP address of the device, and its 
session ID number. Because you connected to the application through the 
Windows Client, this entry should read Windows Device, 127.0.0.1, 
and a session ID number. If you had multiple devices connected to this 
application, additional entries would appear in the Application Users 
list—one for each mobile device.
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Chapter 4: Administrator Settings
This chapter provides information about managing connections and settings 
for the Administrator. It includes:

• Managing Server Connections

• Configuring Studio Settings

• Shutting Down the Headquarters Server

Managing Server Connections

A typical network setup for Studio consists of a full installation (which 
contains all Studio components, including the headquarters server) and one 
or more site installations (which contain only a server and the Administrator). 
Although the Administrator can be opened from any Studio installation, it 
must be connected to the system containing the headquarters server to 
operate.

To connect the Administrator to the headquarters server:

1 From the Administrator, select Connect from the File menu.

The Connecting to Server dialog box appears.

Figure 4-1. Connecting to Server Dialog Box

2 Type the IP address of the system containing the headquarters server in 
the Headquarters Host text box.

3 Click OK.

The Administrator will connect to the specified IP address. Once connected, 
you can manage Studio applications, licenses, and servers from the 
Administrator.
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To disconnect the Administrator:

1 From the Administrator, select Disconnect from the File menu.

The Disconnecting From Server dialog box appears.

2 Click Yes.

The Administrator disconnects from the headquarters server.

NOTE Closing the Administrator does not stop the Studio service.

Configuring Studio Settings

This section presents information on how to configure settings in Studio. It 
includes:

• Configuring Preferences

• Configuring Security

Configuring Preferences

You can configure some Studio preferences directly from the Administrator. 
These preferences fall into two categories: the connection to the headquarters 
server and the browser used to display the online help.

To modify the default connection to the headquarters server:

1 From the Administrator, select Settings from the Tools menu.

The Wavelink Studio Settings dialog box appears.
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Figure 4-2. Preferences Tab

2 Type the IP address of the system hosting the headquarters server in the 
Default Host text box.

3 Click OK.

To configure how Studio’s online help is displayed:

1 From the Administrator, select Settings from the Tools menu.

The Wavelink Studio Settings dialog box appears.

2 If you want Studio to automatically use the default browser for your 
system to display the online help, select the Use Browser Launcher option.

3 If you want to specify the browser that displays the online help, select the 
Specify browser option and type the path to the browser in the Browser 
Path text box.

If you do not know the exact path to the browser, you can click Browse 
to navigate to it.

4 Click OK.
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Configuring Security

To prevent unauthorized use of the Administrator, you can enable Studio’s 
security feature. This feature allows you to create a list of IP addresses that 
are authorized to access the headquarters server.

To configure Studio Security:

1 From the Administrator, select Preferences from the Tools menu.

The Wavelink Studio Settings dialog box appears.

2 Click the Security tab.

Figure 4-3. Security Tab

3 Enable the Enabled checkbox to activate Studio security.

You can now add IP addresses that are allowed access to the headquarters 
server.

4 Click Add.

An Input dialog box appears.
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Figure 4-4. The Input Dialog Box

5 Type an IP address in the Enter IP Address text box.

6 Click OK to return to the Wavelink Studio Settings dialog box.

7 Click OK to accept the list of IP addresses.

If you decide that an IP address is no longer allowed access to the 
headquarters server, you can remove it.

To remove an IP address:

1 From the Administrator, select Preferences from the Tools menu.

The Wavelink Studio Settings dialog box appears.

2 Click the Security tab.

3 Select the IP address from the Valid IP Addresses list.

4 Click Remove.

The IP address is cleared from the list.

5 Click OK.

Shutting Down the Headquarters Server

If you need to shut down the headquarters server, you can do so directly from 
the Administrator application.

NOTE Although you can remotely shut down the headquarters server, you 
cannot remotely restart it. You can only restart it locally.
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To shut down the headquarters of Studio:

1 From the Administrator, select Shut down Headquarters from the 
Tools menu.

A dialog box appears, asking you to confirm that you want to shut down 
the headquarters server.

2 Click Yes.
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Chapter 5: Server Monitor View
The Server Monitor view is your primary means of managing your 
application servers. With the Server Monitor view, you can gather 
information on which servers are in operation, what applications are running 
on each server, and how many devices are connected to each application.

Figure 5-1. Server Monitor View

This chapter presents the Server Monitor view and goes over the information 
available and the tasks performed from this view. Sections include:

• The Site List

• Site Applications & Users Region

• Adding Applications to Servers

• Terminating Applications
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The Site List

At the top of the view is the Site List. This list provides general information 
about each server. The information in this list is as follows:

You can control how many servers appear in the Site List by selecting a group 
from the Server Group list. When you select a group from this list, only the 
servers that belong to that group appear in the Site List. For more information 
about server groups, see  Managing Server Groups on page 74.

If you double-click on an entry in the Site List of the Server Monitor view, a 
dialog box provides additional data for that server:

Name The name of the server. It is recommended that you 
assign names to your servers that make them easy to 
differentiate (for example, their physical locations).

IP Address The IP address of the server.

Host OS The operating system of the computer running the 
server.

Running Since The time and date when the server started.

Connections The number of connections on the server.

Server Group The name of the group the server belongs to.

Name The name of the server. It is recommended that you 
assign names to your servers that reflect their role 
within your organization (for example, their 
physical locations).

IP Address The IP address of the server.

Host OS The operating system of the computer running the 
server.

Connections The number of connections on the server.

Startup Licenses The number of licenses available to the server when 
it first starts.

Incremental Licenses The number of licenses that are provided to this 
server when its supply of licenses is depleted.



Chapter 5: Server Monitor View 39

For information about editing server properties, see  Editing Server Properties 
on page 72.

Site Applications & Users Region

Below the Site List in the Server Monitor view is the Site Applications & Users 
region. This region is divided into two tables:

Figure 5-2.  Site Applications and Users Region

• Applications Table

• Application Users Table

Applications Table

The table on the left side of the Site Applications & Users region is the 
Applications table. When you select a server from the Site List, the 
Applications table displays information on each application available on that 
server. The information in the Applications table is as follows:

Application The title of the application.

Port The port number used to connect an application to a 
mobile device.

Connections The number of mobile devices connected to the 
application.
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If you double-click on an entry in the Applications table in the Server Monitor 
view, a dialog box provides additional data for each application:

For information about editing application properties, see  Editing Application 
Properties on page 51 or Configuring Advanced Application Settings on page 52.

Application Users Table

The table on the right side of the Site Applications & Users region is the 
Application Users table. When you select an application from the 
Applications table, the Application Users table displays information on any 

Name The name of the application.

Type The type of application (Java or Win32).

Running From The directory from which the application is running.

Path The class name for the application.

Last Modified The date on which the application was last modified.

Connection Limit The maximum number of connections to the 
application.

Session Timeout The maximum amount of time that can pass before 
the Administrator times out the connection.

Inactivity Timeout The amount of time that can pass with no activity 
before the Administrator disconnects the user.

Log Priority The priority level for any log entries associated with 
the application.

Restart Attempts The number of times Studio attempts to start the 
application if the first attempt fails.

Restart Pause The length of time that Studio waits between restart 
attempts.

Run at Startup A checkbox that, if enabled, indicates that the 
Application Server must launch the application 
when it first starts.
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users connected to that application. The information in the Application Users 
table is as follows:

Adding Applications to Servers

The Server Monitor view is used to add applications to servers. Once an 
application has been added to the Administrator, you can assign it to a server 
to allow mobile device users access to it.

NOTE See  Adding Applications to the Administrator on page 46 for more 
information on how to add applications to the Administrator.

To add an application to a server:

1 From the Administrator, click Server Monitor.

2 Select a server from the Site List.

3 Click Start Application, located in the bottom-left corner.

The Start Application dialog box appears.

Device The type of device connected to the application.

IP Address The IP address of the device.

Session ID The ID number that identifies the current connection 
session between the device and the application.
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Figure 5-3. Start Application Dialog Box

4 Select the application you want to add to the Application Server.

5 Click OK.

Terminating Applications

You can terminate an application from a server directly from the Server 
Monitor view. A terminated application is no longer associated with the 
selected server; however, the application still remains available to Studio.

NOTE Terminating an application immediately removes any users connected 
to that application from the network.

See  Deleting Applications on page 61 for information on how to permanently 
remove an application from your network.

To terminate an application:

1 From the Administrator, click Server Monitor.

2 Select a server from the Site List.

3 Double-click the application from the Applications table.

The Site Application dialog box appears.
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Figure 5-4. Site Application Dialog Box

4 Click Terminate.

A dialog box asks you to confirm termination the application.

5 Click Yes.

The application disappears from the Applications table.

-Or-

1 From the Administrator, click Server Monitor.

2 Select a server from the Site List.

3 Right-click on the application and select Terminate.
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Chapter 6: Applications View
You can manage applications for your mobile devices by using the 
Administrator’s Applications view. The Applications view allows you to add, 
modify, group, and delete applications for your Application Distribution 
Manager table.

Figure 6-1. Applications View

This chapter explains the Applications view and the tasks accomplished from 
the Applications view. Sections in this chapter include:

• The Application Distribution Manager Table

• Adding Applications to the Administrator

• Locating Applications

• Managing Application Groups

• Editing Application Properties
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• Configuring Advanced Application Settings

• Deleting Applications

The Application Distribution Manager Table

The primary component in the Applications view is the Application 
Distribution Manager table. This table contains the following information on 
each application available to Studio:

Adding Applications to the Administrator

The first step in adding an application to your wireless network is to add it to 
Studio using the Applications view. This step makes the new application 
available to your network so it can be assigned to one or more servers.

After you add an application into the Applications view, you must assign it to 
a server to make it available to your users. See  Adding Applications to Servers 
on page 41 for more information.

To add an application to the Administrator:

1 From the Administrator, click Applications.

2 Click Add.

The Adding New Application dialog box appears.

Name The name of the application.

Type The type of application. There are two types 
available: Win32 and Java.

Port The assigned port number or method for 
determining a port.

Scope The way Studio determines the path to the 
application. There are two values available for the 
scope: relative and absolute.

Last Modified The date on which the application was last modified.
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Figure 6-2. Adding New Application Dialog Box

3 Type the name of the application in the Name text box.

4 Select the application type from the Type list.

Currently, Studio supports two application types: Java and Win32.

NOTE If you are using a Solaris OS, you will not be able to run Win32 
applications.

5 Select the application group from the Application Group list.

6 Select a method for determining which port the application will use from 
the Port list.

• If you want the application accessible from any available port, select Find 
Available.

• If you want the application accessible only from a specific port, select 
Single Port. A text box becomes enabled, which you can use to type the 
port number you want the application to use.

• If you want the application accessible from a range of ports, select Port 
Range. Two text boxes become enabled, which you can use to type the 
start and end port numbers for the desired range. With this option 
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selected, mobile devices can connect to the application through any port 
number that falls within the specified range.

NOTE If you use Find Available when selecting a port for the application, the 
port number may change each time you run the application. This may make it 
difficult to create a firewall exception for the application.

7 Type a description of the application in the Description text box.

This description appears in the Description column of the Application 
Distribution Manager table.

8 Type the path to the directory that contains the application in the Local 
Path text box.

You can also click Browse to navigate to this directory.

9 Type the full application name in the Choose App text box.

NOTE When using a Win32 application, you must include the file extension. 

10 If you want multiple servers to have direct access to the application, select 
the Relative option.

This option instructs Studio to install the application on multiple servers, 
using a path that is relative to the Studio directory.

NOTE The location of the relative directory is automatically determined by 
Studio.

-Or-

If you want mobile device users to access this application from its original 
install directory, select the Absolute on option, and then select the system 
on which the application resides.

With this option, Studio accesses the application only from the system on 
which the application was initially installed, using the exact path specified 
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in the Local Path text box. This option is recommended if you do not want 
an application distributed to multiple systems.

11 Click OK to add the application to the Application Distribution Manager 
table.

You can also configure advanced settings for your wireless applications by 
clicking Advanced. For more information about advanced application 
settings, see  Configuring Advanced Application Settings on page 52.

Locating Applications

If you have a large number of applications available to mobile devices, the 
Application Distribution Manager table can refresh to display a specific 
application.

To locate a specific application:

1 From the Administrator, click Applications.

2 Type the name of the desired application in the text box located above the 
Application Distribution Manager table.

The Application Distribution Manager table refreshes to display the 
desired application.

Managing Application Groups

With the Administrator, you can organize your applications into groups for 
easier management.

These groups can be defined to best fit your organization. For example, a 
group can consist of applications that are used for related purposes or at 
specific sites. This section describes:

• Creating an Application Group

• Deleting an Application Group

Creating an Application Group

Application groups make it easier to access specific types of applications.
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To create a group:

1 From the Administrator, click Applications.

2 Click Groups.

The Manage Application Groups dialog box appears.

Figure 6-3. Manage Application Groups Dialog Box

3 Click Add.

The Adding Group dialog box appears.

Figure 6-4. Adding Group Dialog Box

4 Type a name for the group in the Enter new group name text box.

5 Click OK to close the Adding a Group dialog box.

6 Click OK.
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You can now add applications to the new group. See  Editing Application 
Properties on page 51 for more information on how to add applications to 
groups.

Deleting an Application Group

If you decide not to use an application group after it has been added, you can 
delete it. Any applications in the group when it is deleted will continue to 
function, although they will no longer be assigned to a group.

To delete a group:

1 From the Administrator, click Applications.

2 Click Groups.

The Manage Application Groups dialog box appears.

3 Select a group.

4 Click Delete.

The application group is deleted.

Editing Application Properties

Studio makes it easy to edit your application’s properties, such as the name, 
port used, and group. You make these modifications using the Properties 
button in the Applications view. For information about more advanced 
options, see  Configuring Advanced Application Settings on page 52.

NOTE If mobile device users are currently accessing an application, changes to 
that application’s properties do not take effect for those users until they exit 
and re-load the application.

To edit application properties:

1 From the Administrator, click Applications.

2 Select an application in the Application Distribution Manager table.

3 Click Properties.
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The Application Properties dialog box appears, containing the same 
information described in  Adding Applications to the Administrator on 
page 46.

4 Modify the information about the application as necessary.

5 Click OK.

The new properties will be saved.

Configuring Advanced Application Settings

When you add an application to Studio, you can also configure settings such 
as application arguments, log priorities, and session timeouts. You configure 
these settings from the Advanced Application Settings dialog box.

Studio divides advanced application settings into several tabs within the 
Advanced Application Settings dialog box: 

• Application Arguments

• JVM Options

• Class Path Options

• Log Options

• Session Options

• Recovery Options

Application Arguments

Advanced application options involve adding one or more application 
arguments. These arguments allow you to further customize how the 
application runs on your network.

To configure advanced application options:

1 From the Applications view, select an application from the Application 
Distribution Manager table.

2 Click Properties.
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The Application Properties dialog box appears.

3 Click Advanced.

The Advanced Application Settings dialog box appears. 

NOTE You can also access this dialog box by clicking Advanced from the 
Add New Application dialog box when you add new applications to the 
Administrator.

4 Click the Application tab.

Figure 6-5. Advanced Application Settings Application Tab

5 Click Add.

A dialog box appears.

6 Type an application argument in the Add Item text box.

7 Click OK.

The application argument appears in the Arguments list.
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NOTE To add multiple application arguments, repeat steps 4 through 7 as 
necessary. To edit or remove an application argument, select that argument 
from the list and click Edit or Remove.

8 Configure additional advanced options or click OK to save your changes.

JVM Options

You can add JVM options to control how the Java Virtual Machine operates 
for an application.

To configure JVM options:

1 From the Applications view, select an application from the Application 
Distribution Manager table.

2 Click Properties.

The Application Properties dialog box appears.

3 Click Advanced.

The Advanced Application Settings dialog box appears.

NOTE You can also access this dialog box by clicking Advanced from the 
Add New Application dialog box when you add new applications to the 
Administrator.

4 Click the JVM tab.
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Figure 6-6. Advanced Application Settings JVM Tab

5 Click Add.

A dialog box appears, allowing you to type in a JVM option.

6 Type a JVM option in the Add Item text box.

7 Click OK.

The JVM option appears in the Options list.

NOTE To add multiple JVM options, repeat steps 4 through 7 as necessary. To 
edit or remove a JVM option, select that argument from the list and click 
Edit or Remove.

8 Configure additional advanced options or click OK to save your changes.

Class Path Options

You can use the Advanced Application Settings dialog box to configure class 
path options for Java applications.
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NOTE These options apply only to Java applications.

To configure class path options:

1 From the Applications view, select an application from the Application 
Distribution Manager table.

2 Click Properties.

The Application Properties dialog box appears.

3 Click Advanced.

The Advanced Application Settings dialog box appears.

NOTE You can also access this dialog box by clicking Advanced from the 
Add New Application dialog box when you add new applications to the 
Administrator.

4 Click the Class Path tab.

Figure 6-7. Advanced Application Settings Class Path Tab

5 Click Add.
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A dialog box appears, allowing you to type in a class path.

6 Type a class path in the Add Item text box.

7 Click OK.

The class path appears in the Class Path list.

NOTE To add multiple class paths, repeat steps 4 through 7 as necessary. To 
edit or remove a class path, select that argument from the list and click Edit 
or Remove.

8 Configure additional advanced options or click OK to save your changes.

Log Options

You can use the Advanced Application Settings dialog box to configure the 
logging properties for an application.

To configure logging options:

1 From the Applications view, select an application from the Application 
Distribution Manager table.

2 Click Properties.

The Application Properties dialog box appears.

3 Click Advanced.

The Advanced Application Settings dialog box appears. 

NOTE You can also access this dialog box by clicking Advanced from the 
Add New Application dialog box when you add new applications to the 
Administrator.

4 Click the Log tab.
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Figure 6-8. Advanced Application Settings Log Tab

You can configure the following logging properties for each application.

5 Configure additional advanced options or click OK to save your changes.

Session Options

You can configure how the application behaves on a per-session basis by 
using the Session tab of the Advanced Application Settings dialog box.

To configure session options:

1 From the Applications view, select an application from the Application 
Distribution Manager table.

2 Click Properties.

Log Priority Sets the value of any event logged as a result of this 
application. There are three options available: Info, 
Warn, and Error.

Number Sets the number of log events that can occur for this 
application.

Size Sets the maximum file size for the log.
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The Application Properties dialog box appears.

3 Click Advanced.

The Advanced Application Settings dialog box appears.

NOTE You can also access this dialog box by clicking Advanced from the 
Add New Application dialog box when you add new applications to the 
Administrator.

4 Click the Session tab.

Figure 6-9. Advanced Application Settings Session Tab

5 If you want the application to stop running after a specified period of time, 
enable the Session Timeout checkbox.

Once you enable this checkbox, type the desired amount of time the user 
can access the application in the Days, Hours, and Minutes text boxes. If 
you do not type any values into these text boxes, Studio treats the Session 
Timeout checkbox as disabled.

6 If you want the application to timeout after a period of inactivity, enable 
the Inactivity Timeout checkbox.
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Once you enable this checkbox, type the maximum length of inactivity in 
the Days, Hours, and Minutes text boxes. If you do not type any values 
into these text boxes, Studio treats the Inactivity Timeout checkbox as 
disabled.

7 Type the maximum number of connections allowed for this application in 
the Connection Limit text box.

8 Configure additional advanced options or click OK to save your changes.

Recovery Options

The Recovery Tab in the Advanced Applications Settings dialog box allows you 
to control what Studio does if a port monitor for an application is lost. These 
options include how many attempts Studio makes to restart the port monitor 
and how long Studio waits between restart attempts.

To configure recovery options:

1 From the Applications view, select an application from the Application 
Distribution Manager table.

2 Click Properties.

The Application Properties dialog box appears.

3 Click Advanced.

The Advanced Application Settings dialog box appears.

NOTE You can also access this dialog box by clicking Advanced from the 
Add New Application dialog box when you add new applications to the 
Administrator.

4 Click the Recovery tab.
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Figure 6-10. Advanced Application Settings Recovery Tab

5 Type the number of times Studio will attempt to reconnect to the 
application in the Number of Attempts text box.

6 Type the amount of time, in milliseconds, that Studio will wait between 
restart attempts in the Time to Pause Between Attempts in Milliseconds 
text box.

7 Configure additional advanced options or click OK to save your changes.

Deleting Applications

If an application is no longer necessary, you can delete it from the Application 
Distribution Manager table.

NOTE Deleting an application from the Application Distribution Manager 
table removes it from all servers that previously downloaded it.

To delete an application:

1 From the Administrator, click Applications.

2 Select an application in the Application Distribution Manager table.
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3 Click Delete.

A dialog box appears, displaying the information about the selected 
application in a read-only format.

4 Click Accept to delete the application from the Application Distribution 
Manager table.
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Chapter 7: Licenses View
Studio uses a License Manager to maintain a pool of Wavelink licenses 
available to your organization. When a mobile device attempts to connect to 
the network, Studio uses the License Manager to determine if a license is 
available and, if so, to assign that license to the connection. The License 
Manager is accessible from the Licenses View.

Figure 7-1. Licenses View

For more information about the Licenses View, select one of the following:

• The License Manager

• The Licenses List

• The Currently Issued List

• Adding New Licenses

• Deleting Licenses
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• Reclaiming Licenses

The License Manager

The License Manager maintains a pool of available Studio licenses. Licenses 
are leased to a server for a one-week period. After one week, the licenses are 
reclaimed and the License Manager can re-assign them. This system of 
leasing licenses offers two advantages. First, you can easily move licenses 
from one server to another as usage demands. Second, if you used a 
distributed configuration for Studio, your users can continue to access 
applications even if a connection to a central server is unavailable.

You can allocate licenses from your license pool to a specific Application 
Server. When you allocate these licenses, you determine the number of 
startup licenses (licenses available to the server on startup) and the number of 
incremental licenses (the number of licenses allocated to the server each time 
it reaches its limit of available licenses). For example, you can configure an 
Application Server to have 20 licenses on startup and get an additional 10 
licenses each time the number of licenses available to that server is exceeded. 
The startup and incremental licenses are set from the Servers View. For 
instructions on modifying the number of startup and incremental licenses, see  
Editing Server Properties on page 72. 

NOTE Under normal operating circumstances, a server requests new licenses 
from the License Manager well before its current licenses are reclaimed, 
ensuring that your users always have access to the applications they need.

There are two types of licenses available for Studio: base licenses and 
maintenance licenses. A base license provides authorization for the version of 
Studio that you purchased. Base licenses do not expire, but they do not allow 
you to upgrade to a newer version of Studio. A maintenance license allows 
you to use a base license with a newer version of Studio. For example, a 
maintenance license allows you to upgrade from Studio 4.x to Studio 5.x. 
Maintenance licenses are valid only through a specific date.

The Licenses List

The Licenses view consists of two components. The first component is the 
Licenses list. This list contains the overall information on the licenses 
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available to your Studio installation. The specific information contained in the 
Licenses list is as follows:

The Currently Issued List

The Currently Issued list is the second component of the Licenses view. This 
list displays data regarding where Studio licenses are distributed. The specific 
information contained in the Currently Issued list is as follows:

Adding New Licenses

You can add new licenses to your available license pool at any time. Each time 
you add new licenses, they appear in the Licenses table.

To add new licenses:

1 From the Administrator, click Licenses.

Licensee Name The name to which the license is assigned. Typically, 
this is the name of your organization.

Platform Version The platform version for this license.

Serial Number The serial number for this license.

User Limit The number of users authorized for this license.

Expiration Date The date when this license expires.

Authorization Code The authorization code for this license.

Parent Name The name of the site to which Studio issued licenses.

Number of Users The number of users who currently have a license at 
the site.

Duration The duration that these licenses are available to the 
site before Studio returns them to the pool of 
available licenses.

Expiration The date and time when licenses will be reclaimed 
by the License Manager.
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2 Click Add.

The Add New Wavelink License dialog box appears.

Figure 7-2. Add New Wavelink License Dialog Box

3 Type the name to which the new licenses are assigned in the Licensee text 
box.

4 Type the platform version for the licenses in the Platform Version text box.

5 Type the serial number for the licenses in the Serial Number text box.

6 Type the number of users allowed to access these licenses in the User 
Limit text box.

7 Type the authorization code for the licenses in the Authorization text box.

8 Type the expiration date for the licenses in the Expiration Date text box.

9 Click Accept to add the new licenses to Studio.

Deleting Licenses

When a given set of licenses reaches its expiration date, Studio automatically 
prevents those licenses from being available to mobile device users. You can 
remove licenses before their expiration date by using the Delete button 
found in the Licenses view.
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NOTE After you delete a license, it is permanently removed from your license 
pool. It is recommended that you delete licenses only when absolutely 
necessary.

To delete licenses:

1 From the Administrator, click Licenses.

2 Select the row that contains the licenses you want to delete from the 
Licenses table.

3 Click Delete.

A dialog box appears, asking you to confirm that you want to delete these 
licenses.

4 Click OK to delete the licenses from Studio.

NOTE Deleted licenses already assigned to a server remain active at that 
server until the one week period ends or they are reclaimed.

Reclaiming Licenses

As mobile devices access applications at different times, the number of 
licenses that each server requires increases and decreases. This can result in 
servers having more licenses assigned to them than they currently need.

Typically, unused licenses are removed from a server after one week. 
However, if you want to remove these licenses before that time, you can do so 
by using the Reclaim feature on the Licenses view. This feature removes all 
unused licenses from each server within your network.

To reclaim unused licenses:

1 From the Administrator, click Licenses.

2 Click Reclaim.

A dialog box asks you to confirm that you want to reclaim unused licenses.

3 Click Yes.
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The License Manager reclaims all unused licenses and makes them 
available for distribution to all servers.

NOTE If all licenses assigned to a server are unused, using the Reclaim feature 
leaves that server with a number of licenses equal to the amount established 
Startup Licenses setting. To change the startup licenses setting, see  Editing 
Server Properties on page 72.
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Chapter 8: Servers View
The Servers view provides you with the ability to add, modify, and delete 
servers that are part of your installation. You can also use the Servers view to 
organize your servers into groups in order to manage your servers more 
efficiently.

Figure 8-1. Servers View

This chapter explains the Applications view and the tasks accomplished from 
the Applications view. Sections in this chapter include:

• The Servers List

• Adding Servers

• Editing Server Properties

• Deleting Servers

• Managing Server Groups
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The Servers List

The primary component of the Servers view is the Servers list. This list 
displays the following information on each active server:

You can control how many servers appear in the Server list by selecting a 
group from the Server Group list. When you select a group from this list, only 
the servers that belong to that group appear in the Server list.

Adding Servers

When you install a server, that server does not have immediate access to the 
headquarters server. Consequently, that server does not have access to 
wireless applications or licenses. To allow a server full access to wireless 
applications, you must add it to the network through the Servers view.

To add a server:

1 From the Administrator, click Servers.

2 Click Add.

The Add Master Server Entry dialog box appears.

Name The name of the server.

Startup Licenses The number of licenses available to the server when 
it first starts.

Incremental Licenses The number of licenses that are provided to this 
server when its supply of licenses is depleted.

Server Group The name of the group to which the server belongs.
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Figure 8-2. Add Master Server Entry Dialog Box

3 Type the name for the server in the Name text box.

4 Type a password for the server in the Password text box.

When the server starts, it sends its password to the headquarters server. If 
the password is valid, the server is allowed access to wireless applications 
and licenses.

5 Confirm the password by typing it in the Confirm Password text box.

6 Type the number of startup licenses for the server in the Startup Licenses 
text box.

This text box determines the number of licenses available to the server 
when it first starts.

7 Type the number of incremental licenses for the server in the Incremental 
Licenses text box.

This text box determines the number of licenses that are provided to this 
server when its supply of licenses is depleted.

8 Select a log priority level for the server from the Log Priority list.
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The log priority level determines when Studio generates an alert for that 
server. There are three levels available: info, warning, and error.

9 Type how many log files you want Studio to generate in the Log Number 
text box.

When Studio has created the maximum number of log files allowed, it 
overwrites the oldest log file in the its directory.

10 Type the maximum file size (in kilobytes) for each log file in the Log Size 
text box.

11 Type the port number that this server uses for AutoDiscovery in the 
Discovery Port text box.

12 Select a group to which the new server will belong from the Server Group 
list.

13 Click OK.

The server is now allowed access to licenses and applications.

Editing Server Properties

The Administrator provides you with the ability to edit information on each 
active server within your network.

To edit server properties:

1 From the Administrator, click Servers.

2 Select a server from the Servers list.

3 Click Properties.

The Edit Master Server Entry dialog box appears.
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Figure 8-3. Edit Master Server Entry Dialog Box

4 Edit the properties of the server as needed.

5 Click OK.

The properties are saved.

Deleting Servers

If you uninstall a server, you can delete its entry from the Administrator.

To delete a server:

1 From the Administrator, click Servers.

2 Select a server from the Servers list.

3 Click Delete.

A dialog box appears, asking you to confirm that you want to delete the 
server.

4 Click Yes.

The server is deleted from the Administrator.
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Managing Server Groups

With the Administrator, you can organize your servers into groups. As you 
manage server configurations and activities through the Server Monitor or 
Servers view, you can instruct the Administrator to display only those servers 
that belong to a specific group by selecting that group from the Server Group 
list.

You can define groups to best fit your organization. For example, a group can 
consist of servers that are located in the same geographic region, or that 
manage similar applications such as inventory or sales applications. This 
section describes:

• Creating a Server Group

• Deleting a Server Group

Creating a Server Group

Server groups make it easier to access specific types of servers.

To create a group:

1 From the Administrator, click Servers.

2 Click Groups.

The Manage Server Groups dialog box appears.

Figure 8-4. Manage Server Groups Dialog Box
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3 Click Add.

The Adding a Group dialog box appears.

Figure 8-5. Adding Group Dialog Box

4 Type a name for the group in the Enter new group name text box.

5 Click OK to close the Adding a Group dialog box.

6 Click OK.

You can now add servers to the new group. See  Adding Servers on page 70 for 
more information on how to add servers to groups.

Deleting a Server Group

If you decide not to use a server group after it has been added, you can delete 
it. Any servers in the group when it is deleted will continue to function, but 
will no longer be assigned to a group.

To delete a group:

1 From the Administrator, click Servers.

2 Click Groups.

The Manage Server Groups dialog box appears.

3 Select a group.

4 Click Delete.

The server group is deleted from the Administrator.
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Appendix A: Wavelink Studio Application 
Alerts

During normal operations, mobile device users access applications without 
any knowledge of Wavelink Studio servers or components. However, if a 
problem occurs during a mobile device connection, the Wavelink Studio 
displays an error message on the mobile device. These error messages can 
assist you in locating and resolving the cause of the problem.

The errors that Wavelink Studio currently displays on a mobile device are as 
follows:

General App Error This error occurs when the server attempts to run a 
Java application and gets an exception. Because a 
wide variety of issues might cause this error, you 
should consult your server log files for additional 
information.

Unable to create 
application

This error occurs when the server attempts to run a 
Win32 application and is unable to execute the 
process. Because a wide variety of issues might cause 
this error, you should consult your server log files 
for additional information.

User Limit Reached! This error occurs when the server has run out of 
licenses and cannot accept another connection.

Connection Refused by 
Host!

This error occurs when the server refuses the new 
connection (usually because it is out of licenses).
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Appendix B: Wavelink Contact Information
If you have comments or questions regarding this product, please contact 
Wavelink Customer Service via e-mail or telephone.

E-mail: customerservice@wavelink.com

Phone: 425-823-0111
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